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Preface

Purpose of this guide

This guide provides an overview of current vision technologies and how they can
work together to provide Braille-using students with an effective and independent
means of participating in classroom activities. Each section highlights one stage
of the process, from accessing information and resources to producing print or
braille materials.

This guide is available in print and electronic formats on SET-BC’s web site at
<www.setbc.org>.

Contributors to this guide:

Section 1: Scanning and optical character recognition
Dave Rathwell, School District # 35, Langley

Section 2: Importing and exporting files
Mallory Burton, SET-BC Region 6, North Coast
Vicky Midtdal, SET-BC Region 3, Vernon

Section 3: Braille translation
Carol Graham, SET-BC Region 1, Vancouver Island / Central Coast
Madeline Bailey, SET-BC Region 1, Vancouver Island / Central Coast

Section 4: Information resources
Dave Manzer, SET-BC Region 2, Vancouver / Lower Mainland
Micki Nakashima, SET-BC Region 2, Vancouver / Lower Mainland

Demonstration:
Plugging It All Together

Dave Manzer, SET-BC Region 2, Vancouver / Lower Mainland

Appendix:
Vision Technologies – Product Information
Vision Technology Vendor List
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About SET-BC

Special Education Technology British Columbia (SET-BC) is a Provincial
Resource Program designed to assist BC school districts in meeting the
technology needs of students with physical disabilities and visual impairments.

SET-BC’s mandate is:
• to lend assistive technologies (reading, writing, and communication tools)

where required to ensure students’ access to educational programs, and
• to assist school districts in providing the necessary training for students and

educators in the use of these technologies.

Each BC school district has a SET-BC District Partner who can provide
information on how services are provided for eligible students. For more
information and resources on assistive technology, check SET-BC’s web site at
http://www.setbc.org.
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Section 1:  Scanning and Optical Character Recognition

SCANNING AND OPTICAL CHARACTER RECOGNITION:

WHAT IT IS AND SUGGESTIONS FOR DOING IT BETTER

Part A.  Preliminary Information

Description of student need:

The student with a visual impairment needs the same access to resources as a
sighted student.

Assumptions:

• The school district is committed to providing visually impaired students with
the same opportunity for learning resources as sighted students

• Literacy results from the active process of reading, rather than the passive
process of listening, therefore students who utilize scanned text should do so
via hard copy (translated) Braille or a refreshable Braille display

• The technology described in this document will consist of industry standard
hardware and software i.e. a Pentium computer running Windows 98, an HP
scanner, OmniPage Pro 10, and Microsoft Word 2000

• Due to its graphical interface, OmniPage Pro 10 is not fully accessible to a
blind user. Products by Arkenstone and Kurzweil are better suited to providing
independent access to print, for blind users.

Why Scan?

• Scanning print material and creating e-text is a highly efficient way of
providing source, reference and reading material for Braille using and low
vision students

• Students have access to any and all reading material, thereby encouraging
them to read more

• Material can be provided for blind and low vision students quickly and on-
sight, thus providing them with written information at the same time as their
classmates

• The resulting e-text is not consumable, cannot get lost or misplaced, and is
permanently archived for future students’ reading needs

• Students equipped with a computer and a refreshable Braille display can
carry disks rather than cumbersome multi-volume Braille books

• By using the “find” command in their word processor students can navigate
e-text easier and faster than hard copy Braille
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Prerequisites:

• The school district has the financial resources to provide a $2500.00 (approx)
technology investment

• The school district has the human resources to provide a consistent daily time
allotment for the production of electronic text (e-text)

• Students and support personnel have the necessary Braille and computer
skills to utilize the scanning / OCR process

Equipment Needed:

• Pentium computer (USB port, 64 meg RAM, Windows 95/98)
• Name brand scanner with USB connection (e.g. HP, Epson)
• OmniPage Pro 10 Optical Character Recognition software
• Microsoft Word 97 or 2000

Which Computer?

• Transferring files to your student is much easier if you have the same
operating system as your student. In most cases this will mean that a
Windows computer is preferable

• Scanning speed is directly related to the clock speed of the computer (mHz).
The faster the computer the faster the scan

• The amount of RAM determines how much scanned information and how
many application programs your computer can have open at once. Since
OCR programs and typical word processors require a lot of RAM, the more
the better. A minimum of 64 meg is recommended however,128 meg of RAM
is preferable.

• A USB (Universal Serial Bus) port is preferable in that it provides faster
communication to and from the scanner than the parallel port

Which Scanner?

• USB scanners are faster and free up the parallel port for use with an
embosser. Name brand scanners will lead to fewer system conflicts and
easier configuration with the OCR program.

• Parallel scanners are cheaper but they are considerably slower.
• Some scanners (such as HP) allow one button scanning of graphics which

can be useful for low vision students
• Automatic Document Feeders are a useful add-on for high volume e-text

production



Section 1:  Scanning and Optical Character Recognition

Vision Technologies: Connecting It All -  May 2001
Page 5

Which Optical Character Recognition Program?

• OmniPage Pro 10 is the current industry standard and claims to have the
highest accuracy

• Other OCR programs will work, however, OmniPage Pro 10 allows you to
work directly from within other applications (e.g. Microsoft Word)

• OmniPage Pro 10 allows you to save your scanned work with different
extensions so they will open in a variety of applications (Word, Word Perfect,
PowerPoint, Excel)

Part B. The OmniPage Pro 10 Program

General Information:

• Aside from the standard Windows menu bar and toolbar, the program is
divided into four major parts – the Auto OCR toolbox, the Thumbnail View, the
Image View, and the Text View.

• The Auto OCR toolbox contains buttons (and corresponding toolbars) for
Auto OCR, Manual OCR and the OCR Wizard

• The Thumbnail View displays the scanned pages. Clicking on each page
opens the corresponding recognized text for that page. Pages may be re-
ordered here

• The Image View displays the zones on the page. They can be manually
changed here (see About Zones)

• The Text View displays editable text which can be cleaned up here (see
About Cleanup)

• The toolbar for the Auto OCR button contains settings for the Document
Source, Original Layout, Output Format, and Export Destination in individual
drop down listboxes.

• The toolbar for the Manual OCR button combines the settings for Original
Layout and Output Format.

• Zone templates can be created to pre-define a zone. This is one way of
eliminating unwanted text such as headers and footers. Templates are only
effective if the text is in exactly the same place on each page. Otherwise it is
better to ignore the zone (see About Zones)

• Scans can be scheduled to occur automatically. This allows you to turn the
page and have OmniPage Pro 10 scan the next one, without you having to
press the Start button. This is convenient and saves time.

Major Features of OmniPage Pro 10 (including differences between OmniPage
Pro 10 and earlier versions)
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• Graphical interface with buttons to Start, Stop, and Finish the OCR process
• The process is more extensive in that after the physical scan and transfer of

information, an internal scan and recognition process takes place. This
involves symbol matching and character analysis using three OCR engines
within the program. The result is often a slower process that yields extremely
accurate results

• The “Save”  dialogue box has “basic” and “advanced” options. Choose
“advanced” to see all of the “Save” options (including “retain graphics)

• Graphics cannot be omitted during the scanning process. They can only be
omitted at the time of “Save” by unchecking  “retain graphics”. This results in
a slower recognition process.

• After “saving” a document the program can automatically launch your word
processor and copy the scanned document into it. This is activated by
checking the “Save and Launch” checkbox in the “Save” dialogue box

• The name for the ability to scan from within your word processor has been
changed from “OCR Aware” to “Direct OCR”

• The “thumbnail view”, “image view”, and “text view” windows can be hidden
by clicking the corresponding icon on the status bar at the bottom of the
screen. If you wish to clean up your document in OmniPage Pro 10, hide the
“image view” and “thumbnail view” to provide a larger “text view” window

• The “Defer OCR” option has been removed. Deferring OCR can be
accomplished by scanning all pages in “Manual OCR” then changing to “Auto
OCR” and pressing the “Finish” button. All pages will then be recognized.
Alternatively, the recognition process can be scheduled to take place at a
given time (in Process menu).

Part C.  About Scanning with OMNIPAGE PRO 10

The Process:

Source        Scan                Zone                Recognize               Clean up
             

             Takes a picture    Groups and      Turns graphic of       Fix spelling
                      therefore text is    orders text        text into editable      and format
                      really a graphic    to match            text                          errors
                                                   original

                    Save

 textfile. txt
     or
Word .doc
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About the Source Document:

• Clean copy saves a huge amount of time in clean up
• Examine the flow of text on the page to decide whether or not there are areas

of text that need to be reordered or ignored.
• For close columns you can draw a pencil line between them.  This eliminates

the scanner joining two columns into one zone and creating lines of text that
run across both columns. This applies mainly to older OCR programs

• If the source document is single page and will be carefully oriented with the
top of the page at the top of the scanner, uncheck “Automatically straighten
page image” and “Automatically correct page orientation” in the “Process
Settings” dialogue box (see Process Options). Doing this will speed up the
scanning process. However, if the page is to be put in the scanner sideways
or upside down make sure “Automatically correct page orientation” is
checked.

About Zones:

• In order to reconstruct the page after it has been scanned, the program must
organize it into its component parts. These may be headings, paragraphs,
pictures, captions, sidebars or tables. Each part is separated, enclosed in a
border and becomes a separate zone. Text zones are enclosed in a blue
border and picture zones are enclosed in a green border.

• Only information in zones will be recognized and processed.
• Zones are determined by the program but can be altered using icons on the

“Image Toolbar” (located in the Image View). To activate the “Image Toolbar”
click anywhere in the Image View (except on the toolbar itself as this will not
activate it). The icons on the Image Toolbar allow you to re-draw the zones,
reorder them or change their properties such as ignoring them (useful for
running headers).

• Redrawing zones allows you to combine small zones into one larger one or
split large zones into smaller ones. In most cases this is unnecessary as the
program usually does a good job of determining appropriate zones

• To reorder zones, click on the “Reorder Zones” icon in the Image Toolbar
after it has been activated. All the zone numbers will disappear. Click on each
zone in the new order you want them. Zones will be renumbered accordingly.
Click the “Finish” button. You will be prompted to “Finish processing existing
pages”. Choose this and the page will be reprocessed in the new zone order.
Reordering zones is often necessary when dealing with sidebars which
interrupt the contextual flow of the page.

• Zones may be ignored during processing by selecting them, choosing the
Zone Properties icon from the Image Toolbar and choosing “ignore zone”
from the settings dialogue box that appears. Alternatively, zones can be
ignored by right clicking on them and choosing “ignore zone” as the zone
type. This is an easy way to eliminate running headers and footers that may
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not be appropriate for e-text for Braille using students. This is also simpler
than creating zone templates

• Graphic zones will automatically be ignored if the “retain graphics” checkbox
(in the Save dialogue box) is left blank.

• Changes to the way Image View appears can also be made from the Image
Toolbar. These include rotating the page, straightening the page and zooming
in to make the text on the page larger.

• Many zone changes can be undone by pressing the “Undo” command in the
edit menu (or using Control+Z). This will return the zone to its previous state.

About the “Document Source” Listbox

• If the original text is very crisp black on white use “Scan B&W”. Otherwise
choose “Scan Grayscale” as the “Document Source” setting. Caere
recommends this setting as the one that provides the best overall results.

About the “Original Layout” Listbox

• “Multiple Column” is the safest setting for Braille users because it doesn’t
matter if the source document is in columns or not. Conversely, the “Single
Column” setting  will cause a columned source to be scanned in a single
zone, combining the lines from each column. Graphics will be ignored unless
the “retain graphics” is checked in the “Save” dialogue box. For low vision
students choose “Mixed Page” when columns and/or graphics are present in
order to preserve them.

About the “Output Format” Listbox

•  For Braille using and low vision students the  “Retain Font and Paragraph”
setting works well. It will preserve the original layout of the page, however
graphics will be placed at the bottom of the page.

• If True Page is selected, the exact layout of the page will be preserved,
however the zones will become textboxes, which are harder to edit in Word.

About the “Export Destination” Listbox

• Choosing “Save as File” will cause the Save dialogue box to appear after
each page is scanned and recognized. The Save dialogue box contains
checkboxes for “retain graphics” (in Advanced mode) and “save and launch”
(to automatically launch Word and copy the text into it).  For multi-page
scans, rather than cancel  the Save dialogue box each time a page is
scanned, press the Stop button after the page has gone through the second
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scanning stage (the first time in the Progress Monitor and the second time on
the Status Bar. Choose “add more pages” from the dialogue box that appears
and repeat this for each page. After the last page is scanned choose “process
all pages”. OmniPage Pro 10 will do the final recognition for each page and
open the “Save” dialogue box. Uncheck the “retain graphics” checkbox for
Braille users. If “save and launch” is checked, Word will open (after the file is
named) and the entire document will be copied into it.

• Choosing “Copy to Clipboard” causes each page of scanned and recognized
text to be sent to a temporary folder until it is ready to be saved. Also, the
Finish button is replaced with the Additional button. The Additional button
allows you to continue scanning pages without having the Save dialogue box
open, or having to use the Stop button and “add more pages” as explained
above. To save your document after all pages have been scanned, change
from “Copy to Clipboard” to “Save as File”. Pressing the Additional button will
now open a dialogue box. Choose “export document again” and the Save
dialogue box will open. If you have sufficient RAM (64 or greater), this method
is preferable for multi-page documents.

• Choosing “Read Text Aloud” will cause the page to be read out loud. To save
recognized text after it is read, choose “Save As...”  in the File menu.

Using The “Auto OCR” Button:

• Choosing “Auto OCR” and pressing the Start Button will cause scanning,
zoning, recognizing, and exporting to be done automatically according to the
toolbar settings for  “Document Source”, “Original Layout”, “Output Format”
and “Export Destination”.

• “Auto OCR” corrects upside down and sideways pages if  “automatically
correct page orientation” is checked in the Tools / Options / Process dialogue
box.

• The “Auto OCR” button reproduces text in the same order as the original
page. If this is not the order you want, you can activate the Image Toolbar
after you have used “Auto OCR”. This allows you to redraw,  reorder and/or
ignore the text zones on a page and then re-process the page, after the “Auto
OCR” process is finished.  To do this click in the “Image View” after the page
has been processed and follow the directions for reordering zones and
ignoring zones in About Zones.

Using the “Manual OCR” Button:

• Using the “Manual OCR” button, the individual processes will only be
performed when the associated settings buttons are pressed. Buttons do not
visually appear until the mouse pointer is placed over the label for each
setting. The settings may be changed by clicking on the arrow next to each
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label. Choose settings for “Document Source”, “Original Layout and Output
Format”, and “Export Destination” here. This toolbox is different from the Auto
OCR Toolbox in that the buttons for Original Layout and Output Format are
combined into one.

• It is generally unnecessary to use the “Manual OCR” button as all manual
zone changes can be made via the Image Toolbar, after Auto OCR has taken
place. This includes clearing a border and re-drawing the zone, combining
multiple zones into one, separating large zones into smaller ones, reordering
zones, and changing zone properties (e.g. ignore zone)

• The Manual button can be used to defer OCR (see Major Features of
OmniPage Pro …)

About the Clean Up:

• Cleanup involves the correction of spelling and formatting errors that the
OmniPage Pro 10 (or any OCR) program has made

• Clean up may be done in either OmniPage Pro 10 or your word processor
• If clean up is done in OmniPage Pro 10 check the “automatically proofread

results after OCR” checkbox located in the Tools / Options / Process dialogue
box. After the OCR process you will be prompted to correct the suspect words
on each page .

• It is usually quicker correct the spelling and formatting of the entire document
in the word processor (e.g. Microsoft Word), than to do it one page at a time
in OmniPage Pro 10. This is because you can use the Find and Replace
feature in the word processor to make global corrections to the document.
Word will mark misspelled words with a red underline if  “Check Spelling as
You Type” is activated (Tools / Options / Spelling and Grammar). This makes
them easy to spot.  Uncheck “proofread OCR” in OmniPage (Tools / Options /
Direct OCR) if you are going to clean up in Word. It is redundant to have both
the OmniPage and Word spellcheckers running at the same time and doing
so may lead to system crashes.

About Saving:

• Make subject folders in Windows Explorer on your computer and have the
student do the same. Microsoft Word creates a default data folder called “My
Documents”. You can make subject folders within My Documents however,
this is just another folder that must be opened to get to the subject folder. It is
more efficient if subject folders (on both your computer and the student’s) are
made directly off of the C:\ drive.

• Choose Advanced in the Save dialogue box to see all the dialogue box
choices

• Choose from the “Save As Type” listbox in the Save dialogue box according
to the application program you will use to open it. Checking the “Save and
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Launch” option will cause that application to open. The file will be
automatically copied into the application, after it opens

• For students with their own laptops save the cleaned up document to disk
(“Save As”) after saving it to your hard drive so that you always have a master
document

The “Process Options” Multi-page Dialogue Box:

• This multi-page dialogue box may be accessed page at a time from the Tools
/ Options menu, globally from the Process / Select Process Settings menu or
globally by clicking on the Options icon on the standard toolbar. It may also
be accessed from within registered applications through the File menu /
“acquire text settings”

• An explanation of each setting can be accessed by right clicking on it
• Caere claims a 30% increase in speed if “Fastest” is chosen on the Options /

OCR page (accuracy is compromised so use only for very clear source
documents).

• Source documents in different languages may be scanned and accurately
reproduced if the language is selected on the Options / OCR page

• Scans can be scheduled on the Options / Scanner page. Scheduling a one
second time between scans allows you to turn the page and have the scan
start automatically.

• If you have an automatic document feeder (ADF) activate it on the Options /
Scanner page

• Brightness and contrast may be adjusted on the Options / Scanner page.
Lighten the Brightness setting for thick, run-together text characters and/or
dark backgrounds. Darken the setting for thin, broken text characters. Use the
slider box to manually adjust the contrast between light and dark on scanned
pages. Move the slider to high for light text on dark backgrounds.

• To scan from within Word select “Enable Direct OCR” on the Options / Direct
OCR page. Select “Draw Zones Automatically” to have the document
recognized in Word. Do not select “Proofread OCR” if you plan to use the
spellchecker within Word

• Register applications (Word is automatically registered) on the Options /
Direct OCR page. This puts “acquire text” and “acquire text settings” in the file
menu of the desired application.

• Adjust page orientation settings on the Options / Process page. Do not select
“Automatically Proofread Results after OCR” unless you plan to clean up the
document in OmniPage. Make sure “Automatically Correct Page Orientation”
is selected if pages will be placed on the scanner upside-down or sideways.
Uncheck this and “Automatically Straighten Page Image”, however, if they
don’t apply. Leaving them checked slows down the scanning process.
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Optimum Settings:

• With it’s increased emphasis on accuracy, OmniPage Pro 10 is known to be
slower than previous versions.

• The optimum speed settings for Auto OCR (assuming clear text, right side up
orientation, no zone modifications, and recognition to be done at the time of
scan) is:

OCR Method – Fastest
Automatically Scan Pages – 1 second
Automatically Proofread Results After OCR – unchecked
Automatically Straighten Page Image – unchecked
Automatically Correct Page Orientation – unchecked
Look For Tables - unchecked

• The optimum speed settings for Manual OCR (assuming same as above,
except recognition to be done separately) have the same settings. After all
pages are scanned press the Layout /Format button to have all pages
recognized and then the Export Destination button to save the document.
This is slightly faster than the Auto Process

Known Issues:

• It has been noticed that OmniPage Pro 10 may be slower (but far more
accurate) than previous versions.

• It has been noticed that OmniPage Pro 10 may work slower with HP scanners
than with other brands (This has to do with the drivers that HP scanners use)

• It has been noticed that OmniPage Pro 10 may be somewhat unstable. It may
freeze, refuse to complete the entire OCR process, stop scanning arbitrarily in
the middle of a job or not import into Word when working in that program and
Direct OCR is selected. Once OmniPage Pro 10  becomes unstable it may or
may not run properly after restarting the computer. The preferred way to
regain stability is to completely uninstall the program. To do this:

- Use “Add/Remove Programs” to uninstall Caere Scan Manager
- Use “Add/Remove Programs” to uninstall OmniPage Pro 10
- Use “Find” command to locate any other Caere folders and files, “select
all” and delete them
- Use “Find” command to locate any other OmniPage folders and files,
“select all” and delete them
- Reinstall OmniPage Pro 10 and Caere Scan Manager
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PART D:  Scanning Directly into Microsoft WORD ’97 or 2000

General Information:

• The OCR process can be done directly from within Microsoft Word, making it
fully accessible for blind students to do their own scanning

• The process is generally slower using Word because you must wait for the
entire process before proceeding to the next page. Some time saving settings
can be made when scanning is done in OmniPage Pro 10 (see Optimum
Settings)

• “Direct OCR” must be selected in the OmniPage Pro 10 Options dialogue box
before scanning is possible from within Microsoft Word.

• Source text may be in columns (make sure Original Layout is set to “multiple
columns” in OmniPage). The columns will be replaced with a properly
ordered, continuous flow of text

• Source material may be scanned upside down or sideways (make sure
“correct page orientation” is checked in the OmniPage Options dialogue box
(Tools / Options / Process).

• For Braille using students, graphics will not be retained if the “retain graphics”
checkbox it is not checked in the OmniPage Save dialogue box

• For low vision students graphics will be retained if the “retain graphics”
checkbox is checked in the OmniPage Save dialogue box

• Options for OCR, Scanner, Format, and Direct OCR can be made from within
Word. These options  are found in the Word “File” menu item “acquire text
settings”.  Once chosen a multi-page dialogue box opens. To have graphics
included for low vision students make sure “mixed pages” and “retain font and
paragraph” is selected in the “Format” page of this dialogue box. (Make sure
“True Page” is not selected in the OmniPage “Output Format” listbox or text
and graphics will appear in format boxes that are difficult to edit). Graphics
will be placed at the bottom of the page. If the graphic appears washed out or
is unrecognizable right click on it and choose “edit picture” from the context
menu that appears.  This will automatically correct the resolution of the
picture. Close the “edit picture” window and return to the scanned page.

• For low vision students the font size can be adjusted (however, graphics will
not be enlarged making them disproportionate to the text). It may be
preferable to use a screen enlarging program which will maintain proper
proportions between text and graphics.

The Process:

• Open a “New” Word document
• To have Word underline words that are not scanned correctly, choose “check

spelling as you type” from the Tools/Options/Spelling and Grammar dialogue
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box in Word. This makes it easier to identify misspelled words during clean
up.

• In the “File” menu choose “acquire text settings”. Make settings changes if
necessary (see General Information) and close the dialogue box. You
cannot access templates when working in Microsoft Word.

• In the “File” menu choose “acquire text”. The scan, zone and recognize
process will take place in Word.

• Subsequent scans using “acquire text” from the “File” menu will place text
after the cursor location in the Word document.

• After all source material has been scanned into the Word document it may be
easier to clean up if it has uniform size, font and justification. This will not be
appropriate if retaining original text attributes is important for the student. To
do this, however, choose “select all” in the “Edit” menu. This will highlight all
of the text in the document. Press Control+Spacebar remove all attributes
(bold, italics, etc.). Press Control+L to left justify all of the text and then
choose a size from the toolbar that is easy to work with. Press the Up Arrow
to remove the highlight and place the cursor at the top of the document.

• Save document regularly
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Section 2:  Importing and Exporting Files

Framework:

Description of student need:

Students need to have a way to transfer files between the *Braille ‘n Speak and
the computer.  They may also need to import files such as worksheets, scanned
materials, e-text, or tests created on another computer (Mac or PC) to their
computer or Braille ‘n Speak.

Prerequisite skills to use the technology independently:

1. Create and edit files on the Braille ‘n Speak
2. Format floppy disks
3. Navigate in Windows using JFW
4. Create and edit files in Word using JFW
5. Create and edit files in Duxbury using JFW
6. Navigate in Open and Save dialogue boxes using JFW
7. Connect Braille ‘n Speak to disk drive

Equipment needed at the station:

• Windows desktop with Word and Duxbury (or laptop with external monitor)
• Mac  desktop with Word and Duxbury (or laptop with external monitor)
• Braille ‘n Speak or BrailleLite
• Braille ‘n Speak Disk Drive fully charged (cable, power adapter)
• Floppy disks

Team support needed to ensure technology will be implemented
successfully:

• Familiarity with Windows, JFW, Word, Duxbury, Braille ‘n Speak, and Disk
Drive

• Ability to teach student prerequisite skills listed above
• Ability to teach student workshop tasks listed below

*Although the term Braille 'n Speak is used throughout this section, the basic
principles and procedures apply to the Braille Lite as well.
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Classroom implementation strategies:

• Using the Braille ‘n Speak for note-taking; transferring the notes to a Word
document for polishing and printing

• Using the Braille ‘n Speak for homework; transferring the draft to a Word
document for polishing and printing

• Transferring a Word document to the Braille ‘n Speak so the student can
continue working at home

• Transferring scanned materials, e-text, or other material from a computer
(Mac or PC) to the Braille ‘n Speak for reading or further work

• Transferring materials created on one platform to another, e.g. teacher-made
worksheets and tests

Common barriers or challenges that might occur:

• Unplanned format changes or loss of formatting
• Unplanned changes to Braille ‘n Speak settings
• Charging issues with Braille ‘n Speak and Disk Drive
• Technology compatibility issues

Tasks the VI teachers will do at this station:

• Exporting a file from the Braille ‘n Speak to a floppy disk in both text and
Braille formats using the disk drive.

• Opening the text file in Word.
• Opening the Braille file in Duxbury.

• Creating a new text file in Word and saving it to a floppy.
• Creating a new Braille file in Duxbury and saving it to a floppy.
• Importing the new text and Braille files to the Braille ‘n Speak using the disk

drive.

Additional tasks that will be demonstrated at this station (time permitting):

• Transferring a Word or Duxbury file between Mac and Windows computers
via a floppy disk.

• Troubleshooting transfer problems.
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Importing and Exporting Files using the Braille ‘n Speak

To export a Braille ‘n Speak file that can be opened in Duxbury or Word:

• Connect disk drive and Braille ‘n Speak with cable.

• Turn on the disk drive.

• Turn on the Braille ‘n Speak and open the file you want to send.

• Insert a formatted disk into the disk drive.

• Enter S-chord.
• You will hear “Storage”.

• Enter T to save the file for export as a text file.
• You will hear “Save text. Enter filename”.

• Or:  Enter B to save the file for export as a Braille file.
• You will hear “Braille.  Enter file name.”

• Or:  Enter S to back up the file for future use with the Braille ‘n Speak.
• You will hear “Save.  Enter file name.”

• Enter the filename and extension.

• Use the extension .txt to identify a text file.
• Use the extension .brl to identify a Braille file.
• (Use dots 4-6 to type the period.)

• Enter E-chord to initiate the transfer.
• You should hear a beep on the drive and “okay” when finished.

You can use a pre-formatted DOS disk, a disk formatted on a computer, or a disk
formatted on the Braille ‘n Speak disk drive.  However, formatting a disk using
the disk drive drains the battery quickly.

If you hear “Storage device missing” turn on the disk drive and enter the s-chord.
If you hear nothing, recharge the unit before attempting to save.
If you hear a message about x-modem and y-modem, the disk drive is not being
recognized.  Turn everything off and hook up the cables again.
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To import a file on floppy disk to the Braille ‘n Speak:

• Put the floppy disk into the Braille ‘n Speak disk drive.

• Enter O-chord.
• You will hear “Option”.

• Enter F.
• You will hear “Enter file command.”

• Enter T-chord.
• You will hear “Disk drive.  Enter S to send or R to receive.”

• Enter R.
• You will hear “Enter filename.”

• Enter the name of the file you wish to load from the disk drive.

• Enter E-chord.
• You will hear “Okay”, two beeps on the disk drive, and then “Enter file

command”.

• Enter O.
• You will hear “Enter file to open.”

• Enter the name of the file you wish to open (the one you just received).  This
file will be last in the list of files on your Braille ‘n Speak.

Imported .txt files will be uncontracted, and Braille translation should be turned
off in the Status Menu.  If you are hearing gibberish, go into the Status Menu and
turn Braille translation off. (Status Menu [st-chord], Quick key [t] and [n] to turn
translation off.)

The Braille translator in the Braille ‘n Speak converts Braille to text but cannot
convert text to contracted Braille.  Incoming text files will be uncontracted
computer braille.  If you are using a BrailleLite 40 with Super Flash Rom and
want your student to read the file in contracted Braille, import the file as a text
file, and then use Easy Braille or Quick Braille to translate it to contracted Braille.

Translation should be on to read a contracted Braille file. (Status Menu [st-chord],
Quick key [t] and [y] to turn translation on.)  Duxbury Braille files will probably be
imported in read line mode.  You may want to go into the Status Menu and
change to sentence mode. (Status Menu [st-chord], Quick key [v] and [s] for
sentence mode.)
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Importing and exporting with Word:

To open the file in Word from a floppy disk

• Launch Word and choose the Open command from the File Menu (Ctrl-0). A
dialogue box will come up.

• Choose 3 1/2 Floppy Drive a: in the Look in field.  Select the file you want to
open in the list box.  If the file is not listed, make sure you have All Files
selected in the Files of type field.  The .brl extension should show up, but
the .txt extension may not.

• Press Enter or click OK.

To export a file from Word to a floppy disk:

• Have the file you want to export on the screen.

• Choose Save As from the File Menu.  A dialogue box will come up.

• Type the file name in the File name field, e.g. test.txt.

• Choose 3 1/2 Floppy a: in the Save in field.

• Choose Text Only with Line Breaks from the Save as type field.

• Press Enter or click OK.

You may want to teach your students a little Dos to make locating files a bit
easier.  Typing the path to the file, (e.g. a: science/dinosaurs/triceratops) may be
easier than navigating through the dialogue box.
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Importing and exporting with Duxbury:

To open the file in Duxbury from a floppy disk:

• Launch Duxbury.

• Choose the Open command from the File Menu (Ctrl-0). A dialogue box will
come up.

• Choose a: in the Drives field.  Select the file you want to open in the list box.
If it is not listed, make sure you have the All Files option selected in the List
files of type field.

• Press Enter or click OK.

• Another dialogue box comes up.  In the Template field, choose Standard
Format and in the Import Filter field, choose Duxbury Coded Braille for a
Braille file or Duxbury Coded Text for a text file.

• Click OK.

To export a file from Duxbury to a floppy disk:

• Have the file you want to export on the screen in text or Braille.

• Choose Save As (F3) from the File Menu.  A dialogue box will come up.

• Type the file name in the File name field, e.g. test.brl.

• Choose a: in the Drives field.

• To export a text file, choose Formatted Text from the Save file as type field.
To export a Braille file, choose Formatted Braille from the Save file as type
field.

• Press Enter or click OK.

Do not choose DBT Braille or Duxbury Coded Braille, or the line codes will also
be transferred, and your files will be full of dollar signs and other codes. Braille
files will be imported as contracted or uncontracted, depending on how they
appeared in Duxbury.
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Transferring files between Mac and Windows:

Macs can read disks formatted on Windows machines, but Windows machines
cannot read Mac disks.  So, use Windows (Dos-formatted) disks when
transferring between the two platforms.

• To format a Windows disk on a Mac, click once on the disk to select it,
choose Erase Disk from the Special Menu, and choose Dos 1.4 MB from the
format pop-up menu. On a Mac, the letters PC will appear on the floppy disk
icon of a Dos-formatted disk.

• Cross-platform transfers using the same program usually work well, provided
that the two versions of the program are similar.  A Word 97 file from
Windows can be opened by Word 97 on a Mac, and all the formatting will be
preserved.  A later version of a program can generally open earlier versions.

• To check the version of Word on a Mac, launch the program and choose
About Microsoft Word from the Apple Menu or click once on the program icon
and choose Get Info from the File Menu.  To check the version of Word for
Windows, launch the program and choose About Microsoft Word under the
Help Menu.

• To check the version of Duxbury, launch the program and choose About DBT
under the Help Menu.  The most recent build date for DBT will be the most
recent release of the program.

• Most Save As dialogue boxes will contain a pop-up menu that lets you select
the format in which you want to save a file. Earlier versions, cross-platform
versions, and cross-application versions are often included in that list.  You
may have to experiment to find which works the best.  Saving as a text file will
usually work as a last resort, but you will lose all your formatting.

• Most Open dialogue boxes will contain a pop-up menu that lets you select the
type of file you want to open.  If you do not see the file you want to open,
choose the all files option in the file type field.
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Troubleshooting Disk Drive Transfer Problems:

For further help see:

Blazie, Bryan J., Getting Started:  A Teacher’s Guide to the Braille ‘n Speak,
Second Edition., Blazie Engineering, 1993, pp. 73-79.

Braille ‘n Speak Manual, pp. 82-86.

Cook, Graham.  Braille ‘n Speak:  A Public Domain Document to Assist
Teachers, 1994, pp. 58-60.

Svendsen, Kathryn.  Teacher’s Quick Reference Guide
To Braille ‘n Speak Commands, May 1977 Revision, pp. 32-37.

To check what was transferred to the disk from the Braille ‘n Speak or
computer:

• In Windows, open the .txt or .brl file in Word or Notepad (make sure word
wrap is on under the Edit Menu).

• On a Mac, open the file with Simple Text or Word.
• Contractions will be shown as ASCII equivalents, e.g. the number 4 for a

period.
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Section 3: Braille Translation

Framework:

Description of student need:

The student needs to access Word resources in braille.

Assumptions:
1. student will work in Word to complete assignments
2. the braillist will use the Duxbury translation program to produce braille

classroom materials for the student
3. the braillist will use the Duxbury program to translate student work (which is

produced in Word) into braille
4. the student will use the braille hard copy to proofread and will edit in the text

document

List of prerequisite skills:
• familiarity with Windows
• familiarity with Word
• familiarity with Duxbury
• familiarity with a Braille printer

List of equipment needed:
• a computer with a windows system with memory of 32 mg
• Microsoft Word
• Duxbury 10.2e or Duxbury 10.3
• print printer – compatible with pc
• braille printer

Team support needed to implement technology:
• braillist (to produce, proofread and ensure that the braille is in proper format)

Classroom implementation strategies:
• braillist will prepare, in advance, any materials needed for classroom activities
• student will use braille materials in curriculum activities (ex. math sheets

should be in braille)
• student will complete daily work in braille or text and braillist will produce a

copy for the teacher when required

Challenges that might occur:
• loading software
• locating application in Windows (hint: add the program to the start menu or

create a hotkey keystroke)
• see handout “Start Menus and Shortcuts”
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• hooking up equipment – correct cables in proper ports, setting equipment
parameters to work with all equipment at station.  See handouts on Braille
printers, Romeo and Versapoint and on Duxbury settings for the Versapoint.

Styles:

About styles in MS Word

Styles define the appearance of various text elements of your document, such as
headings, captions, and body text. Styles make formatting your document easier.
Additionally, they serve as building blocks for outlines and tables of contents.

About styles in Word transporting to Duxbury

DBT Win Version 10.2e or 10.2
“ DBT now recognizes several of the most commonly used MS Word styles, and
equates them with DBT styles.”

Note of caution:
DBT trainers indicate that the name of the style in Word must not be changed or
Duxbury cannot recognize it.  Try the styles and see which transport accurately
into Duxbury.  For example, the style ‘Block text” is a style available in Word that
does not format correctly in Duxbury. You can modify styles in the
Word/Styles/Modify option, but you cannot change the name of the style if you
wish the style to be transported to Duxbury.  Duxbury v10.3 features a list of the
Word styles that will import successfully into the Duxbury Braille Translation
program in their Help Menu under the heading: How DBT Maps MS Word Styles
to DBT Styles

Word Styles:

Title
Use this setting to center a title in 16 pt. bold.
Characteristics:  normal+font:  Arial, 16 pt, Bold, Kern at 14 pt, centered,

space before 12 pt. after 3 pt. Level 1

Body
Use this setting for the text of the document.
Characteristics:  normal + space after 6 pt.

List number
Use this style for an indented list with automatic numbering
Characteristics:  normal + indent:, hanging 0.25”, numbered, tabs: 0.25”

Note:  The first line in the numbered indent does not indent properly if you
choose a list number style other than ‘List number’.
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List bullet
Use this style for a bulleted list
Characteristics:  normal + indent; hanging 0.25”, bulleted, tabs: 0.25”,

automatically update

Note:  The first line in the bulleted indent does not indent properly if you choose a
list bullet style other than ‘List bullet’.

Block Text
Use this style for an indented blocked paragraph
Characteristics:  normal + indent; left 1” right 1”, space after 6 pt.

This style does not format properly when imported by Duxbury.

Braille Translation Station

Activity 1, Part 1: Using Styles in Word
Using the following styles:
• Title
• Body text
• List number
• List bullet
• Block text

Create the following document in Word:
• Open a new Word document. ctrl + n
• Set the style for a centered, bold title alt o, s, t arrow down to title,

enter
• Write the title Vancouver. Hit enter to

move to next line
enter

• Set the style for the body of the document
and enter text for body.

• Write three sentences about Victoria

alt o, s, b arrow down to
body text, enter

• Hit enter at the end of the paragraph.
• Write Attractions:
• Hit enter to move to next line.

enter

enter
• Set the style for a numbered list

• List five tourist attractions that are in
Vancouver.

• Hit enter to move to next line.

alt o, s, l arrow down to list
number, enter

enter
• Set the style for the body of the document alt o, s, b arrow down to

body text, enter, enter
• Write Things to buy:
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• Hit enter to move to the next line.
• Set the style for a bulleted list.

enter
alt o, s, l arrow down to list
bullet, enter

• List 4 gifts you might purchase while in
Vancouver.

• Hit enter to move to the next line. Enter
• Set the style for a blocked, indented

paragraph
alt o, s, b block text, enter

• Copy the following quote about Stanley Park:
Both incredible and beautiful, this one thousand acre
wilderness park is located only blocks from the downtown
business and shopping sections.

• Save this file on the desktop, name it
Vancouver.

ctrl + s, name, enter

• Print this file ctrl + p, enter
• Exit Word File menu, exit

Activity 1, Part 2: Duxbury Braille Translation

• Open the Duxbury Braille Translation
Program.

double click DBT

• Open the file Vancouver file/open/find file on
desktop/double click

• Print a print copy ctrl + p
• Translate the document. ctrl + t
• Emboss a braille copy. ctrl + e
• Check the formatting.
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Set Up For Versapoint Braille Printer To A Toshiba Laptop
Computer With Windows 95

The Toshiba needs to be configured as follows:
1. Go into printers and install new printer—choose generic
2. Now open Duxbury

Under the menu ‘global’ choose embosser setup

Choose Windows device—Generic device

The Versapoint needs to be set at parallel port.
The embosser needs to be turned on before you send the message to print from
the computer.

If you wish to make any changes to the Versapoint perimeters follow these
instructions:

1. Make sure the Versapoint is turned off.
2. Make sure the Versapoint is on line
3. Press and hold the line feed button and the power switch at the same time
4. Line feed = no

Form feed= yes
Top of form = exit

5. Press form feed to say yes at all options that you want to keep
6. When you get to the option that you want to change, press line feed to say

‘no’. Keep pressing ‘no’ until it runs through the different options available to
you. When you get to the option that you want, then press form feed to say
‘yes’.

7. Push top of form to exit. It should read store on setup.
8. Push form feed to say yes.
9. Push top of form x2.

Trouble with Printing

If you are having trouble getting the correct braille when embossing, then try this:
• Go into the control panel on the Toshiba and select ‘Toshiba hardware setup.
• You will see a list of hardware.
• If you don’t find the hardware setups here, then go to the Start

Menu—programs—Toshiba utilities and you will see the hardware setups
here.

• Select printer port—the selected port should probably be ‘standard bi
directional’.

Prepared by Madeline Bailey
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Set Up For Versapoint Braille Printer To A Toshiba Laptop
Computer With Windows 98

The Toshiba needs to be configured as follows:

1. Go into Duxbury under the Global Menu
• Go to Embosser Setup
• Choose Versapoint from the list and make sure that the LPT 1 port is

selected
• Change settings for line length, etc., at this time, then close Duxbury

2. Open ‘My Computer’ and double click on the Control Panel
• Double click on ‘Toshiba Utilities’ (it may also be listed as ‘Toshiba

Hardware’).  If you don’t have either of these folders in the control panel
then you must load them from your Win 98 system

• Select the ‘parallel port’ or ‘printer port’ tab--choose standard bi-
directional—click on ’Apply’ and close

3. The Versapoint should be set at the factory default setting (0)

Prepared by Madeline Bailey /2001
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Set Up For Romeo Braille Printer to a Toshiba Laptop

Note: cover the low paper indicator with masking tape.

The Toshiba needs to be configured as follows:

1. Go into the control panel and select Toshiba hardware setup
You will see a list of hardware. Choose printer port.
If you do not find the hardware setups here, then go to the Start
Menu—programs—Toshiba utilities and you will find the hardware setups
here.
Choose printer port standard bi directional should be selected

2. Go into printers and install new printer—choose generic

3. Now open Duxbury
Under the menu ‘global’ choose embosser setup
Choose Windows device—Generic device

The configurations for the Romeo when using the Toshiba are the Romeo’s
default configurations.

1. Turn Romeo on
2. Go off line OL

Go to service menu 0.0E
Restore default settings 95E
Reset embosser to online 1E

Now you are ready to turn your computer on. Open the file that you want to
print. Translate it to braille in Duxbury and print to embosser.

Suggested Duxbury embosser setup
Max char per line 32
Max lines per page 25
Desired char per line 32
Desired lines per page 23
Top margin 2
Binding 0

Prepared by Madeline Bailey
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Set Up For Romeo Braille Printer To A Braille ‘N Speak

Note: cover the low paper indicator with masking tape

First, you need to set the menu in the Romeo Braille Printer:

1. Go off line OL
2. For Braille n’ Speak you need

Menu 2 0.2E
3. Hardware handshake on 8.1E
4. To set these settings to default 1.0E
5. Return to top of line 1.1E

Now turn the printer off.
Hook up the cables from the serial port on the Romeo Braille Printer to the
Braille ‘n Speak.
Turn the Braille ‘n Speak on.

1. Open status menu ST chord
2. Set the menu as follows: 9600 Baud

no parity
8 data bits
1 stop bit
hardware handshake on
line length 40
top margin 0
left margin 0
page length 0

3. Exit the status menu E chord

Turn the Romeo Braille Printer on.

Open the file that you want to print from the Braille ‘n Speak.

1. Go to the top of the file L chord
2. Send message to print T chord
3. Print in braille B

If at any point you want to stop the printing you must first send the message to
the Braille ‘n Speak to abort printing by doing a Z chord (twice). Then you must
clear the buffer in the printer by:

1. Going off line OL
2. Indicate menu 0.2E
3. Go back to the top of line
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Set up for a Versapoint Braille Printer to the IBM Desktop

The IBM needs to be configured as follows:

1. Go into the control panel – into printers and select generic printer.

2. Open Duxbury and go into the Global Menu.
Open the Embosser Setup menu.
Select Versapoint from the top pull down menu.
Go to the ‘Port’ configurations  menu and choose ‘window device’.
Beside the ‘window device’ selection is a pull down menu. Pull this menu
down and choose ‘generic/text only on LPT1’.

3. The character settings, etc. that usually work with these two units are as
follows:

Maximum characters per line 30
Maximum lines per page 25
Desired characters per line 30
Desired lines per page 23
Top margin in lines 2
Binding margin 0

Prepared by Madeline Bailey
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Exploring Duxbury’s Capabilities for Mathematics

Resource Development Project
November 1998
by Madeline Bailey and Constance McAvoy

Duxbury Strengths:

1. Braille Documents that are produced can be saved and produced again at a
later date.

2. A person who does not know braille can input math questions (using Duxbury
math codes) and translate this to braille for the student. However, the nemeth
should be checked at some point by a braille interpreter.

3.  For more advanced math, it is possible to six key entry nemeth in a Duxbury
      document which produces braille only.
• A  student can use six key entry to produce nemeth and get a braille copy. (If

you work in six key entry, JAWS will not speak). We assume that the
refreshable braille display would address this problem but we were unable to
test this.

Duxbury Weaknesses:

1. Entry in Duxbury does not produce a print copy, thus the work cannot be read
by the math teacher.

2. If you import a math file from Word to Duxbury, it produces the content in
literal braille.

3. JAWS does not read the braille entry.  The student cannot verify input through
JAWS.

4. Some math function symbols need to be cut and pasted from the list of
characters – not an easy task for a visually impaired student.

5. There are formatting problems with six key entry (i.e. tables and automatic
wrapping).

Prepared by Madeline Bailey
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Working In

DUXBURY ver. 10.3

Working with Duxbury Templates

Working with Electronic Text

Duxbury Help Menu Tutorials

What’s New in Duxbury 10.3
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WORKING
WITH

DUXBURY TEMPLATES (ver. 10.3)

Templates created in Duxbury, store very specific information:  document settings and
styles.  You cannot store any text in a Duxbury template.  This makes them quite
different from the typical template that you might create in a word processor such as
Word.
Duxbury templates are basically confined to the Duxbury environment.  It is
possible to import a Word document into a Duxbury template, providing you have
used compatible styles.

Why would you want to create a template in Duxbury?  According to a Duxbury
technician, the most common reasons for creating Duxbury templates are:
1. to number the first brailled page as page 1
2. to create a specific style for a specific task—for example:  a skipped line

between paragraphs

Example 1:
Create a page numbering template that will number the first page of your brailled
document as page 1

How do you create this template?
1. open the Duxbury program
2. go to the file menu and choose ‘new’—select the standard format template

from the document settings menu—press ok
3. go to the document menu—choose ‘create a template’
4. name your template (be sure to give your template a name that will clearly

identify it for future use)—press ok

How do you customize this template?
1. open the Duxbury program
2. go to the file menu and choose ‘new’—select your new template from the

document settings menu—press ok
3. go to the document menu—choose ‘page numbering’
4. change the number in the box ‘First page number to display’ from 2 to

1—if you wish the page number to be in the bottom right corner instead of
the upper right corner (default) then change this as well—press ok

How do you save this template with the new customized style?
1. After customizing your template go to the document menu—choose

‘create a template’
2. click on the name of the template that you have just made the style

changes to
3. press ok—DBT will ask ‘replace existing ____’and you should click on yes
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4. you can now create a document in Duxbury in this template or you can
import a Word document into this template and your first page will be
numbered one.

Example 2:
Create a template that will skip a line between paragraphs
.
How do you create this template?
1. open the Duxbury program
2. go to the file menu and choose ‘new’—select the standard format template

from the document settings menu—press ok
3. go to the document menu—choose ‘modify style’
4. choose para. from the list by clicking on it once—press ok
5. you will now see the codes—the codes should read:

beginning codes: [p]
the ending code will need to be changed to read:
ending code: [sc1]
press ok

6. save the modified style by pressing yes
7. go to the document menu—choose ‘create a new template’

name your new template and press ok
8. go to the file menu and choose ‘close’—disgard this document by pressing

‘D’

Applying your new template:
1. Open the Duxbury program
2. Go to file menu and choose new—select your new template—press ok
3. Go to layout menu and choose ‘apply style’
4. Choose para. From the list and press ok
5. Now create your document by writing several paragraphs—remember that

when working in Duxbury the keystroke for a new paragraph is Ctrl M
(you may also import a Word document into this template if you wish)

6. Translate the document into braille  Ctrl T  --you should be able to see the
skipped line formatting

7. Emboss your document  Ctrl E

You have now successfully created two templates—one with a setting change
and one with a style change.

NOTE:

You cannot modify or delete either of Duxbury’s default templates—Standard
Format and Textbook Format.
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Working with Electronic Text in Duxbury v10.3

Electronic text is simply a text version of written material in electronic format.  In
electronic format, text can be saved to disc or hard drive, imported into word processing
documents, etc.  Complete books, novels, essays and other materials are now available in
this form.

There are various places to access electronic text, for example:
• From the Internet – almost all materials that are not currently under copyright

are available on the Internet.  To practice downloading electronic text you
may wish to try the site www.ldresources.com and link to their Electronic Text
pages

• From scanned materials translated with OCR software
• From PRCVI or other organizations /resources

Duxbury makes braille translation of electronic text (“etext”) and text from a web page
quick and easy.  This is a great feature now that electronic text is becoming more widely
available.

How to import electronic text into Duxbury:

1. Access electronic text and save it as a text file or save a web page as an html file in a
folder of your choice on the hard drive.  You will usually have the option of saving
either way, under the ‘Save as type’ pull-down menu (Alt-F, A, tab until you hear
‘Save as type’ and down arrow to either ‘text file’ or ‘html’ and hit Enter to select
your choice)

2. Launch Duxbury, then open (Ctrl-O) your saved electronic text file from the folder
where you saved it previously.  Duxbury will usually automatically import the text

• in either a text format -  Formatted text (Windows)
• or in an html format – SGML/ICADD/HTML
When opening an html document, in the Import File dialogue box, choose the
Import Filter: SGML/ICADD/HTML (Ctrl-O, tab to Import Filter box, down
arrow to SGML/ICADD/HTML, hit Enter)

Note: Sometimes when importing text from an html format you will have strange
lines of text that represent formatting and graphic items on the web page that will not
make sense in a text format.   If it is possible, you may wish to edit the text to ‘clean
it up’ before translating and embossing the file

3. Translate the document (Ctrl-T) as usual, and emboss

http://www.ldresources.com
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DUXBURY ver. 10.3
HELP MENU TUTORIALS

THAT WE FOUND VERY HELPFUL

OPEN THE DUXBURY PROGRAM
GO TO THE HELP MENU
GO TO THE TRANSCRIBER’S GUIDE (NEW)

For our section on Word Styles and Duxbury:
Chapters:

Chapter 1—Working With Styles
Chapter 3—Creating MS Word Documents for Braille Translation

Appendices:
Appendix B—MS Word Styles

For our section on Templates:
Chapters:

Chapter 2–-Working With Templates

Other interesting reading:
Chapters:

Chapter 6—Formatting according to BANA Standards with DBT
Appendices:

Appendix F—DBT for Windows Shortcut Keys
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WHAT’S NEW

IN

DUXBURY ver. 10.3
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NEW WITH DUXBURY ver. 10.3
IMPORTING TABLES

Duxbury have indicated to us that you can now import ‘tables’ created in Word into the
Duxbury program ver. 10.3, however, they import in a ‘stair step’ format.
For example:     cat

food
dog

Even though Duxbury are referring to this as a new feature of Duxbury ver. 10.3,
it is our opinion that this is still not an effective representation of converting table
information.  As a matter of fact it would be rare that the information from a table
would convert to a ‘stair step’ format and still maintain the context of the original
table.
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NEW WITH DUXBURY ver. 10.3
IMPORTING

ITALIC AND BOLD WORDS

Italic and bold will now import from Word to Duxbury, however there was a
programming error with the use of the italic indicator with a sequence of four words.  The
fix for this is on the Duxbury site at the following address:
www.duxburysystems.com/download.asp#updates
The fix is called—DBT Win Service Release 1 (dated 2001-4-18) for ver. 10.3
This fix “corrects the number of words to be treated by double italic indicators”.
Note:
When installing this fix on your computer make sure that you extract it to the Duxbury
program on the ‘C’ drive and not DBT docs.  The password is:  pre59adjspec

IMPORTING A WORD DOCUMENT INTO DUXBURY VER. 10.3
THAT CONTAINS ITALIC OR BOLD WORDS

1. Italic and bold words will import from Word to Duxbury correctly providing you
have installed the Duxbury fix (2001-4-18) onto your computer into the Duxbury
program ver. 10.3.

2. The italic and bold words must be within regular text in your Word document in
order for Duxbury to recognize them as such.  Duxbury will not recognize italic
or bold words that stand alone in a Word document.

http://www.duxburysystems.com/download.asp#updates


Electronic Resources - E-Text, Encyclopedia & Internet

Vision Technologies: Connecting It All -  May 2001
Page 41

Section 4: Electronic Resources

This section will look at access to print that is in electronic form. This involves
E-Text which are books on disk, encyclopedias on computer CD-ROM and
textual information from the World Wide Web or Internet. The focus of this
section is on the JAWS user but there are also some notes for the large print
user who uses Zoomtext, Magic or Write OutLoud. Each of the three components
of this section will be considered separately. Although each component shares
many features with the other two by considering them separately it is hoped that
they will clearly provide all the relevant information.

E-Text – An Introduction:

Students who are blind require access to alternate format, digital, electronic text
materials accessible through speech, refreshable Braille and/or magnification.  E-
text, or electronic text, is a computer readable electronic file that duplicates a
physical, print text such as a textbook.  E-text is strictly text.  There are many
types of e-text including ASCII or Text (.txt), Rich Text Format (.rtf), Word Perfect
(.wpd) and Word (.doc).   Most of the e-text produced for PRCVI comes in ASCII,
Word Perfect and Word.   Graphic information (pictures, charts and graphics)
found in the print textbook should be made available to the student. PRCVI
provides an accompanying tactile diagram booklet(s) for many titles. If another
supplier provides e-text without tactile diagrams and if it is determined that these
graphics are necessary for the students’ understanding, then they should be
made available. Students proficient with computer technology can create their
own e-text using a scanner and appropriate OCR software (e.g. Arkenstone
Open Book or Kurzweil)

Prerequisite to using e-text:

Student needs to have basic computer and word processing skills. They also
require basic operating skills for their screen reader (e.g. JFW 3.7) and/or their
screen magnification program (e.g. Zoomtext Level 2 or Magic). Braille
notetakers (e.g. Braille ‘n Speak, BrailleLite or Braille Note) may also be used to
access e-text.

Equipment necessary

• computer with enough hard drive space to download an e-text book
• word processing software (MS Word or Write Outloud ver. 3) that can read e-

text files. Note that Wordpad is not sufficient for e-text files
• screen reading and/or screen magnification software technology or
• Braille notetaker with enough space to upload the e-text file(s).
• e-text materials (allow a minimum of 5 months production time for e-text

ordered from PRCVI)
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Necessary Team Support

• Positive attitude to the use of e-text
• Competency in using hardware and software
• Basic troubleshooting skills
• Sense of humour

Classroom Implementation Strategies:

• Start young – share simple stories, for example, classmate stories can be
made available on disk (remember to include descriptions of pictures and
graphics and/or construct a supplementary tactile diagram booklet)

• Read beginning “chapter” books in e-text

• Provide instruction concerning copyright issues

• Provide a Braille or Large Print hard copy to complement the e-text when the
student is learning to use e-text

• Encourage the experienced user to choose the medium that best suits the
specific task.

• Keep the “original” safe. E-text should be saved on the students hard drive
(C:\) in the subject folder

• E-text is often provided in many individual files. It may be  necessary to
provide instruction on how to merge and append these files in order to build
the book (see section Using E-text Textbook with MS Word 2000)

• Provide instruction concerning format issues with respect to Table of Content,
Page Number Location, and Graphic Descriptions

• Use the Find feature to locate page, keywords, and markers

• Use copy and paste features to input information into a new document

User Profile Checklist:

In order to successfully use e-text the following skills are necessary:

1.  View and open files from a floppy disk.
2.  Navigate the Treeview and Listview in Windows Explorer.
3.  Create new folders in Windows Explorer.
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4.  Rename files in Windows Explorer.
5.  Copy and paste documents within Windows Explorer.
6.  Understand extensions (.doc .txt .wpd .rtf).
7.  Open, read and save Word and/or Word Perfect documents.
8.  Open, read and save Notepad and Wordpad documents.
9.  Copy and paste (multiple) e-text file(s) contigously from the floppy disk into a
single file (merge or append).
10. Use the Find Text command to navigate the textbook file.
11. Move (within the application) between the textbook file and files made for
notes and assignments.
12. Move between application programs.

Using an E-text Textbook with MS Word 2000 and JFW 3.7

For demonstration purposes we will use Across the Centuries by Beverly J.
Armento et al.

Opening and copying your e-text textbook to the “subject” folder:

• Turn On the Computer.

• Put the E-text disk in A:Drive.

• Go to Start Menu (Ctrl + Esc), select Programs (P), select Windows Explorer
and press enter.

• Select C:\ and open the File menu. Select “New” and choose “Folder”. Name
the folder according to the subject.

• Make a new folder within the subject folder and name it “textbook”

• In Windows Explorer select 3 1/2”  Floppy (A:) by using up arrow and press
enter.   All the files on the A drive will be shown. Select all of the files on the
disk (Ctrl + A).   Copy them into the “textbook” folder.

• Open a new document in Word.

• Return to Windows Explorer (Alt+Tab). Copy each file from the “textbook”
folder and paste it into the new document. Make sure that the cursor is at the
bottom of the new document after each file is pasted so that text is placed
contiguously.

• Save the new document (which now contains the collated book) with the book
title into the subject folder.
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• Delete the “textbook” folder

Reading E-Text in Large Print Format:

• Open the collated file

• To read the book in Large Print using MS Word choose Select All from the
Edit menu

• Go to the Font listbox and select the desired font size

• Hit enter

• E-Text may also be read in Large Print Format using screen magnification
software

Inserting a Marker to save your place

• Insert a marker to find your place easily the next time you open the file by
typing in a code word (nonsense word e.g. lookingfor) at the spot where you
would like to open the file next time.

• Save file. (Ctrl S)

• When you open the file the next time use the  “find” command (Control+F) on
the code word and the file will open at that place. Do not use common words
as they will be found in other places in the file.

Saving and Closing E-Text File

• When finished open the File Menu and choose Save or Save As. Make sure
you are saving in the subject folder

Note: Keep your original disks safe. Use them only to copy onto another disk or
hard drive, not as working disks. You can lock a disk by opening the disk tab.

Grolier CD-ROM Encyclopedia

Framework

Description of Student needs:

Our low-vision and blind students need an independent method of accessing
resource material for research projects.  With the availability of appropriate CD-
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ROM multi-media resources like the Grolier 1999 or 2000 Multimedia
Encyclopedias, coupled with access to the Internet, computer-centered
"information retrieval" promises to provide unencumbered access for these
students.

A large print user may use many different CD-ROM encyclopedias. The screen
review or JAWs user is limited to Grolier 1999 or 2000 since these are the two
versions that are accessible to JAWs currently.  JAWs is screen review software
for Windows that allows a blind user to browse, find and copy information
contained in these non-print, multimedia resources.

Prerequisite skills to use the technology independently:

• Good JAWs skills for navigation within Win ME/98.
• Practiced ability to switch between open applications (JAWs, Word & Grolier).
• Effective word-processing with JAWs skills for navigating, selecting, copying

and pasting.
• Familiarity with multiple pane pages. Windows Explorer with its List and Tree

views are an example of page with multiple panes.
• Understanding of multiple cursors and how/when to use them.
• If the student is going to use the Internet search features of Groliers, then

some limited familiarity with JAWS access to the Internet.

Equipment Needed:

• Windows ME or 98 based computer
• Word-processing program, MS Word for Windows is the most accessible to

JAWs
• JAWs 3.7 (patch .087) screen review software.
• Internet Explorer 5.5
• Grolier 1999 or 2000 Multimedia CD-ROM Encyclopedias.
• If the student is going to use the Internet search features of Groliers then

Internet access in place (LAN or Modem)

Team support needed to ensure technology would be implemented
successfully:

• Good JAWs skills with respect to complex (multi-media) screen presentations.
• Introduce JAWs & Windows concepts.
• Set up Grolier’s before student tries to use software. Out of the box, it is not

fully accessible to the JAWs user.
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• If the student is going to use the Internet search features of Groliers then
setup Internet Explorer as the web browser for Grolier.

Classroom implementation strategies:

• Show student how to access the extensive help documentation contained
within JAWs.  (Open JAWs; Open Help Topics; Open Contents Page; Open
Popular Applications with JAWS Book; Open Reference & Educational Book;
Open JAWs Specific Keystrokes.  For an explanation of each keystroke &
some related information Open JAWs Specific Keystrokes and then Open link
Detailed Description of Keystrokes.)

• Practice word-find and subsequent cut & paste sequences within Word using
JAWs.

• Practice sentence and paragraph moves as above.
• Use CD ROM resources for basic search exercises.
• Use "voice only" component of JAWs and have student paraphrase or make

sequential notes from found information, switching to word-processor to write.
• Capture single sentences from found information and copy & paste to word-

processing program.
• Coach user in keeping “keyboard command sets” differentiated as they switch

between programs. (JAWs vs Windows vs Groliers)
• Access sound clips and recordings from within Groliers.
• Copy paragraphs for subsequent editing and manipulation.
• Access Internet with structured access provided by Groliers.

Common barriers or challenges that might occur:

• Some features of Groliers are completely graphic (not text) and as such are
not accessible to JAWs.

Tasks that the VI Teacher will do at this station:

• Undertake the steps required in a basic research project using Groliers 98
and its "automated" Internet search capabilities.

• Copy, paste and manipulate selected text.

Why use the Internet?

JAWS 3.7 is designed to work seamlessly with the Internet using Microsoft
Internet Explorer ver. 5.5.
A great deal of useful information is available online to students who are blind.
This includes information that is not otherwise available in any other medium.
Examples of this information are:
• Newspapers and magazines
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• E-text books
• Source documents and reference material needed for reports and

assignments

Pre-requisite skills:
• Familiarity with basic computer operation
• Familiarity with JAWS including multiple cursors and when to use them
• Familiarity with Internet Explorer 5.5
• Familiarity with a word processor

Equipment Needed:
• Pentium computer with modem or network card installed and configured
• Access to the Internet through an internet service provider (ISP) or network

About JAWS and the Internet:
• The student has choices as to how they access web pages. The two basic

choices involve whether or not to reformat the page.
• If the page is reformatted all graphics will disappear, links will appear

separately, and the text (with embedded links) will follow. JAWS will
announce links and frames as the student moves through the web page

• If the page is not reformatted and the virtual cursor is used, JAWS will read all
aspects of the page including links and frames until it reaches the end of the
page. Graphics will be retained. There is greater verbosity using the virtual
cursor, however, it can be more difficult to navigate the page if the automatic
reading done by the virtual cursor is stopped.

• Explanations of JAWS commands related to Internet Explorer 5.5 can be
found within the JAWS Help files. To find these commands open JAWS Help.
Then open the “Contents” page. Open “Popular Applications with JAWS”.
Open Internet. Open Internet Explorer 5. Open JAWS specific keystrokes. If
additional detail is required open the “detailed description of keystrokes” link.

Internet Navigation:
• Use the TAB key to move through links on the page or use the Links Listbox

to access them separately
• URL addresses can be inputted directly in the address field at the top of each

page, rather than from the menu bar.
• JAWS will announce how many links and how many frames are present on

each page when the virtual cursor is used
• The student can move back and forth between visited links using Alt + left or

right arrow

Internet Concepts:
• Information is found on the internet using “Search Engines”.
• The choice of search engines is important. Desirable features include: few

graphics; options to search “any word”, “all words”, or “as a phrase”;



Electronic Resources - E-Text, Encyclopedia & Internet

Vision Technologies: Connecting It All -  May 2001
Page 48

• Meta-search engines search other search engines to find more sites relevant
to the search query

• Stand alone programs such as Copernic (www.copernic.com) search many
other search engines and provide a list of query results in the form of links.
Choosing a link opens Internet Explorer and goes to that website. All search
results are saved within the program for future reference.

• Relevant web material can be copied from Internet Explorer (Edit menu) into
a word processor and saved for future reference

http://www.copernic.com


Demonstration Session: Plugging It All Together

Vision Technologies: Connecting It All -  May 2001
Page 49

Demonstration Session: Plugging It All Together

Connecting a Braille ‘N Speak 640

To connect a Braille ’n Speak or Braille Lite 18 to an Apple ImageWriter II :
recommended

The Apple ImageWriter II printer is a Serial, Dot Matrix, print printer. Use a
special order, BnS 640 to ImageWriter II cable (available from Aroga part
#BNS-004,  $50.00).
• Cable has an 8 socket, female, rectangular plastic plug at one end and a

round, Mac-like, 8 pin Mini DIN, male plug at the other end.
• Plug the 8 socket, female, rectangular, plastic plug at one end into the Serial

port on the Blazie note taker.
• Plug the other end that is a Mac-like, 8 pin, Mini DIN, male plug into the

ImageWriter II.

To connect a Braille ’n Speak or Braille Lite 18 to an Apple ImageWriter II :
not recommended

The Apple ImageWriter II printer is a Serial, Dot Matrix, print printer. Use a
standard BnS Serial Interface cable provided with BnS 640 or Braille Lite 18.
• Plug the 8 socket, female, rectangular, plastic plug at one end into the Serial

port on the Blazie note taker.
• Plug the other end (DB-25, pin, male plug) of the Serial Interface cable into

the Female to Female gender changer (provided with note taker in the BnS
Serial Interface Kit [6 pack]).

• Plug into the other female end of the gender changer the DB-25 end of a Mac
to Serial Printer cable.

• Then plug the Mac-like, 8 pin, Mini DIN, male plug into the ImageWriter II.
This cable is not recommended since it is composed of 2 cables and one
adapter that could come apart and because the cost is as much or more than
the specialty cable.

ImageWriter  II BnS 640/18
BnS to ImageWriter II cable

8 pin round end 8 socket rectangular end

Mac

Image 
Writer II

gender changer

8 pin rectangle

Mac - Serial 
Printer Cable BnS 640, 18

25 pin 25 pin
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To connect a Braille Lite 40 to an Apple ImageWriter II:

The Apple ImageWriter II printer is a Serial, Dot Matrix, print printer.
• Use a special order, BL40 to ImageWriter II cable (available from Aroga part

#INS-004, $50.00)  (Cable has a round, Mac-like, 8 pin Mini DIN 8 pin, male
plug at both ends).

• Check and see if Mac or IIgs to ImageWriter II cable will work.

To connect a Braille ’n Speak 640 to a Epson or Raven or other Parallel, dot
matrix printer:  (BNSP-1) - Traditional

Since the 640 does not have a parallel port, you need to use a special order
Serial to Parallel converter. For this reason many schools have used an Apple
ImageWriter II printer since it is serial.  If a serial printer is not available, then
parallel printers can work with a 640 as long as a special order Serial to Parallel
converter is used. Traditionally we have used a Serial to Parallel converter
available from Aroga (Part # BNSP-1, $90.00).

The BNSP-1 cable is made up of two separate cables.
• The first cable has an 8 socket, female, rectangular, plastic plug at one end

and a DB-25, socket, female plug at the other end.
• The second cable is a short, but conventional cable that is readily available in

stores.  It is an IBM computer to Centronics Parallel printer cable.  It has a
DB-25 pin, male plug at one end and a Centronics Parallel plug at the other
end.

Connect the two cables that make up the BNSP-1 together.
• Then connect the 8 socket, female, rectangular, plastic plug to the serial port

of the 640.
• Then connect the Centronics Parallel end to Parallel plug on the printer.
• Fasten the butterfly clips to secure the Centronics Parallel end to the printer.

To connect a Braille ’n Speak 640 to a Epson or Raven or other Parallel, dot
matrix printer:  (SP-200) - New

The SP-200 is a new, Serial to Parallel converter that appears to be superior to
the BNSP-1. It is significantly cheaper and may last longer as it plugs directly into
the print printer and doesn’t get banged around as much as the BNSP-1.

Use the standard BnS Serial Interface cable provided with the BnS 640 or
Braille Lite 18 to connect the two devices.
• Plug the 8 socket, female, rectangular, plastic plug at one end into the Serial

port on the Blazie note taker.
• Plug the other end (DB-25, pin, male plug) of the Serial Interface cable into

the DB-25, socket, female plug of the SP-200.
• Plug the Centronics end of the SP-200 into the Centronics port of the printer.
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Connecting A Windows Laptop to A Parallel Print Printer

• Windows is most commonly used with parallel, print printers like Epson,
Raven and others.

• Get an IBM computer to parallel printer cable. It has a male DB-25 plug at
one end and a Centronics, parallel plug at the other end.

• Plug the DB-25 end into the printer (LPT-1) port on the back of the laptop.
Ensure that the screws are holding, but not tightened. Plug the Centronics
end into printer. Secure the “butterfly” catches.

• Turn on printer and if you haven’t already done so install new printer in
Windows.  (Start Menu - Settings - Printers - add printers).

• Ensure that the printer is on line and has paper loaded correctly.

• These directions can be used without any changes with a Windows Desktop.
To use a Parallel, Braille embosser with JAWS Laptop, follow the same
procedure, except Install Printer within Duxbury for Windows and not Control
Panel - Printers.
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Switch Boxes: Supporting Independence & Reducing the Confusion

Problem:

The gordion knot of cables that accompanies equipment for the visually impaired
is often confusing for sighted people. For the Braille user it can be very
intimidating. The use of a switch box can often allow for successful, independent
use of the equipment by the Braille user. The Switch Box (sometimes referred to
as an A/B Box) reduces the need to plug and then unplug the cables between
your note taker, computer and your printer(s) every time you want to change
devices.

Notes:

• There are many possible combinations of equipment and how to connect
them. No one way is the right way. The simplest, cheapest, most durable and
with the least amount of changing settings is almost always the best way, but
not the only way.

• Assemble all of the equipment first. It is easier and more cost effective to
design in a connection at the start, rather than to add one in later.

• Usually, reserve the parallel interface for print, printers, since that is
sometimes the only print, printer that an IBM will recognize.

• Get a Switch box that is as simple as possible. Make sure that it is a
mechanical, 25 conductor, all switched, switch box (no buffer; no automatic,
no smart, no electronic features).

• Once you have put it all together and got it working - diagram the setup and
label all your cables and components.  Also record all the settings in all
devices (Status Menu etc.).

• All cables should be shielded and good quality with screws / nuts so they can
be fastened together.
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Blazie Notetaker Using A/B Switch Box to Print or Emboss

Notetaker Switch Box - Serial

• Connect BNS 640 or Braille Lite 18’s serial port to Common plug on switch
box.  You will need to use the Serial Interface cable that comes with the 640
or 18.  Plug the 8 socket, rectangular end into the Serial port on the 640 and
the DB-25, pin, male end into the common (In/Out of I/O) plug on the switch
box.

Or

Connect the Braille Lite 40 Serial port to the Common plug on the switch box.
You will need to use the Serial Interface cable  that comes with the Braille
Lite 40.  Plug the 8 pin, Mini DIN, plug into the Serial port located on either
end of the Braille Lite 40.  Plug the DB-25, pin, male end into the Common
plug on the switch box.

IMAGE WRITER II

BLAZER / XX

BNS 640

Braille Lite 
18

Braille Lite 40

Common or In/Out or I/O

8 pin rectangular

Serial interface cable 
comes

w/Braille Lite 40

8 pin Mini DIN plugs into either end of 40

Serial interface cable 
comes 

with 640 & 18

Mac to serial printer cable

DB 25, male - 
DB 25 male str thru

DB-25 male       
8 pin mini DIN

Label
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• Connect the “A” plug on switch box to the ImageWriter II, print printer.   You
will need a Mac to Serial Printer cable.  Plug the DB-25, pin, male end into
the “A” plug on switch box.  Connect the  8 pin, Mini DIN, (Mac like) plug into
the ImageWriter II.

• Connect the “B” plug on switch box to the Serial port on the Braille Blazer (or
the Romeo Braille) Printer.   You will need a DB-25 pin male to DB-25 pin,
male straight thru cable.  Plug one end into the “B” plug on the switch box.
Connect the other end to the serial or RS232 plug on the Braille embosser.
Make sure that the embosser is set to Serial and not Parallel.

• Label the “A” setting Apple ImageWriter and the “B” setting Braille, Blazer or
Romeo Braille.  It is arbitrary what these are labeled.  Choose something that
is meaningful and easy to remember for the student.

• Turn on and test that you can both emboss and print from the Blazie
notetaker.  Since this is using a serial interface you most likely will not require
any special  power up sequences.  If it doesn’t work ensure that you can print
directly from the Blazie notetaker to each printer in turn.

Note:
You will want to set ImageWriter and Blazer to the same Serial setting so that
you don’t need to change the Status Menu settings each time you switch printers.
Most efficient is to start with Default Settings and then arrive at common settings
with the fewest changes.

Braille Notetaker
Default Settings

Blazer
Default Settings

ImageWriter II
Default Settings
by dip switches

(Warm Reset)
Baud rate 9600 Baud rate 9600 Baud rate 9600
Bits / char 8 Bits / char 8 Bits / char 8
Stop bits 1 Stop bits 1 Stop bits 1
Parity N for none Parity N for none Parity N for none
Handshaking software Handshaking software Handshaking software

Append line feed when transmitting On.
Note: is no longer required with newer Blazie notetakers

change to serial port
change voice to off
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Typical Values

Set Print line length 72
Set left margin 8 Leave at defaults
Set lines per page 56
Set top margin 4

Set Braille line length 32 Leave at 0
Set Braille left margin 2 Leave at 0
Set Braille lines per page 25 Leave at 25
Set Braille top margin 1 Leave at 0
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Laptop & Braille Lite 18/40 640 W/Serial Braille Printer

May require a 25 - 25 gender changer 9 - 25

LPT-1
LAPTOP IBM 25 - 25 Straight Thru Cable

A
B A   B

Common on In/Out or I/O

25 pin straight 
thru cable

25 pin male

25 pin male

RS 232
BLAZER 
SERIAL

Braille Lite 18 
or Braille’n Speak 640
Serial interface cable

Braille lite 40 serial interface
cable can be plugged into either end.

Braille Lite 40

Braille Lite 18

Braille’n Speak 640

8 pin retantangular

8 pin retantangular

9 pin Mini DIN “Mac “ like

COM 1

or

or

or

DB 25 pin male

DB 25 pin male
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Braille Switch Box - Serial

• Connect the laptop’s Serial port (Com 1) to the “A” plug on switch box.  You
will need: a 9-25 adapter (look in Braille ’n Speak / Braille Lite Serial Interface
kit - also known as a 6 pack) and a DB-25 pin, male to DB-25 pin, male
straight through cable.  (not null modem cable)  Connect the 9-25 adapter
to the 9-pin male Serial port.  Connect the straight through cable to the “A”
plug on the switch box.

• Connect the Braille ’n Speak 640 or Braille Lite 18 from the Serial port 8 pin
rectangular to the “B” plug on the switch box.  You will need: the BnS Serial
Interface cable that comes with the 640 or 18.  It has an 8 socket,
rectangular, female end at one end and a DB 25, pin, male end on the other
end.

Or

Connect the Braille Lite 40 from the smart Serial / Disk drive port (either end
of the Braille Lite 40) to “B” plug on the switch box.  You will need the BL-40
Serial Interface cable that came with the Braille Lite 40.  It has a 9 pin, mini
DIN “Mac-like” plug at one end and a DB-25 pin male connector at the other
end.

• Connect the DB-25 male to DB-25 male, straight through cable  from the
Common plug on the switch box to the serial (RS-232) plug on the Braille
printer.  Note the Common plug may be labeled In/Out or I/O as well.

• Label the “A” switch setting  Laptop or something meaningful by student.
Label the “B” setting Braille ’n Speak, Braille Lite or something else that is
meaningful to student(s).

• Turn on and test that you can emboss from both devices.  In most cases you
will not need to power up in any specific order.  Just ensure that the AB
switch setting is appropriate, that the Braille printer is on line and then Print.
If that doesn’t work, turn everything off.  Connect directly and emboss.  In a
few cases you will find it necessary to observe a specific power-up routine but
this is unusual for Serial printing.

• Label all cables-both ends. Diagram the complete system and record all
settings required e.g. Duxbury, Blazie notetaker Status Menu & Braille
embosser settings.
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Laptop & Blazie Notetaker Sharing Parallel, Print Printer

Print Switch Box - Parallel

• Connect the laptop’s Parallel (or printer) port  (LPT-1) to the “A” plug on the
switch box. You will need a DB-25, pin, male to DB-25, pin, male straight
through cable.

LPT-1      COM  1

LAPTOP

A / B
A
B

RAVEN (parallel)

25 pin straight thru cable

BRAILLE LITE 18

BNS 640

BRAILLE LITE 40

25 pin stu thru cable

BNSP-1 + 25 pin stu thru cable

Special cable not yet available

Label
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• Connect the Braille Lite 18’s Parallel port to the “B” plug on the switch box.
You will need a DB-25, pin, male to DB-25, pin,  male straight through
cable.
Note: the Print command is T-Chord and then a second T-Chord to print to a
Parallel print printer.

or,
Connect the Braille Lite 40’s Parallel port to the “B” plug on the switch box.
You will need:
• a special order cable that is not yet available.  You will need a Braille

Lite 40 parallel plug to DB-25, pin, male cable.
or,

Connect the BNS 640 to the “B” plug on the switch box.  In order to do this
you will need:
• a Special order cable Serial to Parallel converter (cat #BNSP-1, cost is

$90.00 available from Aroga) and a DB-25, pin, male to DB-25, pin,
male straight through cable.

Connect the 8, socket, rectangular end of the BNSP-1 to the Serial port on
the 640.  Connect one end of the DB-25, pin, male to DB-25, pin,  male
straight through cable  to the DB25 female end of the BNSP-1.  Connect
the other end of the straight thru cable  to the “B” port on the switch box.

Note:  the Print command remains unchanged on the 640 it is “T-Chord” and
then a “T”.

• Connect the Common or In/Out or I/O plug on the switch box to the
Centronics, Parallel plug (the one with the “butterfly” latches) on the print
printer. You will need an IBM computer to parallel printer cable.  It has a
DB-25 pin, male plug at one end and a Centronics Parallel plug on the other
end.

• Label the “A” switch setting “Laptop” or something meaningful to the
student(s).  Label the “B” setting “Braille ’n Speak”, “Braille Lite” or something
else that is meaningful to student(s).

• Turn on and test that you can print from both devices.  With parallel devices
you may need to power up in a specific order.  Test first to see if you can
switch the setting on the switch box, turn on printer and then print.  If it
doesn’t work remove the switch box and test that it will print directly from the
laptop or the Blazie notetaker to print printer.

Note:
If you are using a parallel-pass-thru-printer (so that you can connect a scanner to
the laptop without buying a PCMCIA, SCSI interface card) be advised that the
switch box may not work and/or it may adversely affect the scanner’s operation.
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Braille Lite 2000  (18 )
Manufacturer :        Freedom Scientific, Inc.    www.freedomscientific.com
Local Distributor:   Aroga Marketing Group   www.aroga.com
The Braille Lite 18  is an electronic word processor with Braille input,  an  18 cell
refreshable Braille display,  and speech output.   It can input over 2000 pages of
Grade 2 Braille and has a built-in reverse translator
for automatic printing of documents in either Braille
or print.  It has cursor routing buttons, choice of 6 -
or 8-dot Braille, and also has keys to facilitate
direct input of  dot-7 and dot-8 when entering
ASCII Braille or foreign language notation.   It also
includes a talking clock, calendar, calculator, and
telephone directory; the word processor  includes a
spell checker.

Braille Lite 40
Manufacturer :        Freedom Scientific, Inc.    www.freedomscientific.com
Local Distributor:   Aroga Marketing Group   www.aroga.com
The Braille Lite 40  is an electronic word processor with Braille input,  a  40 cell
refreshable Braille display,  and speech output.   It can input over 2000 pages of
Grade 2 Braille and has a built-in reverse
translator for automatic printing of documents in
either Braille or print.  It has cursor routing
buttons, choice of 6 - or 8-dot Braille, and also
has keys to facilitate direct input of  dot-7 and
dot-8 when entering ASCII Braille or foreign
language notation.   It also includes a talking
clock, calendar, calculator, and  telephone
directory; the word processor  includes a spell
checker.   The Braille Lite weighs 2  lbs.  and has 768k RAM memory and 4MB
ROM  memory.

Braille Note
Manufacturer :        Humanware      www.humanware.com
Local Distributor:   Aroga Marketing Group  www.aroga.com

Braille Note combines  high quality Braille and
speech.  The BrailleNote features an infra-red port,
internal modem, PCMCIA slot , serial and parallel
ports. You can communicate electronically using
BrailleNote’s Pop-3 e-mail  program, read
documents in Grade 1 or 2 Braille.  The BrailleNote
comes in either 18- or 32-cell refreshable Braille
display.  It has a 21 - hour  battery life.

http://www.aroga.com
http://www.aroga.com
http://www.aroga.com
http://www.humanware.com
http://www.freedomscientific.com
http://www.freedomscientific.com
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Clearview 700 & Spectrum SVGA 
Manufacturer :        Optelec    www.optelec.com
Local Distributor:   Aroga Marketing Group     www.aroga.com
The CCTV is a closed circuit television that enlarges text
and graphics from a printed page. It allows people with low
vision toaccess printed materials by displaying the enlarged
image on a monitor. Through the use of a camera it
magnifies the page up to 64x. It also allows for the
foreground and background of the page to be modified if
necessary.  Monochrome or  color display.
These models have the following capabilities: Split Screen ,
accepts computer input SVGA ,
compatible with both Mac & Windows computers but must use PC monitor.
Manufacturer: Telesensory
Model: Aladdin
Split Screen capability
Accepts computer input SVGA
Compatible with Windows computer

Duxbury Braille Translator
Manufacturer :        Duxbury Systems Inc.
Local Distributor:   Aroga Marketing Group   
www.aroga.com
Duxbury  Braille translation software ( Win or  Mac
platforms) allows you to create accurate Braille for textbooks,
letters and other formats, regardless of your familiarity with
Braille formatting rules.  It includes an importer for Microsoft
Word files, translation to Nemeth code  mathematics and
supports inclusion of embosser graphics files. Compatible
with speech output and refreshable Braille displays.

Jaws for Windows
Manufacturer:       Henter-Joyce Inc.
Local Distributor:  Aroga Marketing Group  www.aroga.com
Jaws for Windows  is a screen reading software program for Windows and Windows
NT. It automatically adjusts itself to the application program being used, tracking menus
and color bars.  Smart Screen  speaks dialogue boxes, pop-up windows, error messages or
other prompts that appear on the screen.  A dual - cursor
design   lets you move freely about with the Jaws cursor,
while the PC cursor remains ready to communicate with your
application program.   Other features include: built-in macro
user-definable keys; single- handed access to important
screen-reading function keys; ability to selectively read any

http://www.optelec.com
http://www.aroga.com
http://www.aroga.com
http://www.aroga.com
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window on the screen.  Jaws for Windows  features support for Microsoft Internet
Explorer , including the ability to read pages on the internet without reformatting and a
links list dialog box.  Jaws for Windows includes an enhanced “ Eloquence for JFW”
software speech synthesizer, as well as he Microsoft text-to-speech engine.  Dectalk
Access 32 is also available as an addition.

Mountbatten Pro
Manufacturer:        Humanware Inc.    www.humanware.com
Local Distributor:   Aroga Marketing Group  www.aroga.com

The Mountbatten Brailler Pro is a standard Braille writer  that incorporates an erase
and correction feature, tabs, automatic margin settings, and memory.  It has a
silent Braille keyboard that enables users to Braille directly onto
full size  Braille paper or  silently into a memory to print at
a later time.  The Mountbatten can be driven by an
external keyboard for one-handed users or from a standard
qwerty keyboard.  It now has both digitized and synthetic
speech; you can combine typing and touching braille with the audio
reinforcement of real speech confirming the letter or dot combinations you have brailled.
the synthetic speech enable a student to create an assignment , edit text , then produce a
copy of the assignment in braille.

OmniPage Pro 10
Manufacturer:      Caere Corporation
Local Distributor:  Educational  Resources  1-800-220-0521
OmniPagePro is an optical character recognition (OCR) application for Windows  and
NT.  It has the ability to translate character images into editable
text.  Scanners capture the image of a page and then digitize the
image into a bitmap which can be stored, printed, and
manipulated by a computer.  The text cannot be edited by a word
processor until an OCR program has processed the bitmap.  New
features of OmniPage Pro  include improved recognition of poor
quality documents,  voice read-back, proofreader, spreadsheet
handling, color support,  integration with Microsoft Office, and
can retain original page layouts.

Romeo Braille Printer
Manufacturer:         Enabling Technologies   www.brailler.com
Local Distributor:    Aroga Marketing Group
www.aroga.com

http://www.humanware.com
http://www.aroga.com
http://www.brailler.com
http://www.aroga.com
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There are 2 models: the Romeo 25 and the Romeo Pro 25. The Romeo 25
prints at a speed of 25 characters per second  while the Pro 25 prints at a speed
of 50 characters per second.  They have a 40 character (standard braille) line,
weigh 31 pounds , and use 20 to 100 pound form feed Braille paper.  The Romeo
25 standard features  include Dynamic Braille Scaling which lets you change
Braille sizes even within a document , as well as,  graphics in normal and high
resolution.
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Vision Technology Vendor List

Aroga Marketing Group Inc. www.aroga.com
1611 Welch Street, North Vancouver, BC V7P 3G9
Phone: 604-986-7999 Fax: 604-986-7070

Braille Blazer
Braille Lite 40
Braille ‘n Speak
Duxbury
Jaws for Windows
Romeo Braille Printer

Blazie Engineering www.blazie.com
105 E. Jarrettsville Road, Forest Hill, MD 21050
Phone: 410-893-9333 Fax: 410-836-5040

Braille Blazer
Braille Lite 40
Braille ‘n Speak

Caere Corporation www.caere.com
100 Cooper Court, Los Gatos, CA 95032
Phone: 408-395-7000 Fax: 408-354-2743

OmniPage Pro

Educational Resources www.edresources.com
PO Box 45680, Surrey, BC V4A 9N3
Phone: 1-800-565-5198 Fax: 1-800-663-5093

Educational Software
Grolier
OmniPage Pro
Microsoft Office

Freedom Scientific  http://www.freedomsci.com/
Henter-Joyce, Blazie and Arkenstone have joined to form Freedom Scientific –
creating assistive technology products for people with sensory and/or learning
disabilities.

Henter-Joyce Inc www.hj.com
11800 31st Court N., St. Petersburg, FL 33716-1805
Phone: 727-803-8000 Fax: 727-803-8001

Jaws For Windows

http://www.aroga.com
http://www.blazie.com
http://www.caere.com
http://www.edresources.com
http://www.freedomsci.com
http://www.hj.com
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Optelec         www.optelec.com
1832 Marie-Victoria Blvd., Longueuil, Quebec J4G 1T9
Phone (450) 677-1171 or (800) 665-3005   Fax: (450) 677-1462

BrailleNote

http://www.optelec.com

